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Introduction

1.1 Preface

Dear customer,
in the first instance we want to thank you that you made your decision on a product of OKM
Ortungstechnik GmbH.
With the Rover C you purchased a product which is based on a electromagnetic pulse method which can
be used to locate anomalies in the target area. Thus the device is able to detect natural features such as
formations of strata, cavities, groundwater level as well as sepulchers or buried objects such as pipes,
tanks, boxes or suchlike.
The Rover C is able to locate, to document and to analyze buried objects with different structures,
without making necessary any excavation. Particularly in areas next to the surface there are many
advantages to geoelectric, seismic and magnetic procedures and it is further more a useful complement
to these methods. The Rover C has a facile and flexible handling and provides fast and easy reproducible
results.
With our team of specialists we guarantee that our products are under recurrent control. Our specialists
try to implement new developments in terms of further quality improvements for you.
Of course by selling our products we cannot guarantee that you really make a find during your research.
The recognition of hidden objects and structures depends on a huge number of factors - like you know.
Determining factors are the dielectric constant of the ground, the grade of mineralization and the
dimensions of an object relating to its depth. Specially in very wet soil, clay and sand with high
conductivity of the ground, recording of the measured results can be falsified strongly.
With this product you purchased a device which stood the tests in regular operation like all other
products of us. If you are interested in where our devices have gone into action please visit our
homepage.
For our company it is necessary that we protect our developments within the framework of existing
legislation to a patent or trademark registration. Therewith we offer you a higher warranty while using
our products.
Please take your time consecutively, read this user‘s manual and familiarize yourself with the utilization
and operation of this Rover C.
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1.2 Important Notes
Please read these operating instructions carefully and closely before using Rover C and its accessories!
These instructions give information on how to use the device and point out potential sources of danger.
Rover C and its accessories serves for documentation and analysis of detect objects deposited and
changes performed in the ground. The registered data of the ground structure will be transmitted to a
PC for visual representation in a special software program using the components we offer. Any
additional notes relating to this has to be observed. Please read attentively the manual according to the
software you are using!

1.2.1 General Notes
Being an electronic device, Rover C has to be treated with the caution and care necessary when such
devices are used. Any failure to observe the safety precautions given or any use for purposes other than
the ones it is conceived for may result in a damage or destruction of the processing unit and connected
components.
The device will get destroyed if it is opened improperly.

1.2.2 Possible Health Hazards
If used properly the device normally does not pose any health hazards. According to current scientific
knowledge, the high-frequency signals are not harmful to the human body on account of their low power.

1.2.3 Surrounding Area
Having been transferred from a cold to a warmer place, the device should not be operated immediately
afterwards. Any condensation, which may have formed, might cause the device to get destroyed. Avoid
strong magnetic fields, which may occur in places such as near machines or loudspeakers, and avoid
using a detector within a radius of 50 meters.
Metallic objects on the ground such as cans, doses, catches, nails, screw or others can influence
negatively your measurement and have to be removed. Also you have to remove keys, telephones, chains
and rings and all other magnetic and metallic objects from yourself.

1.2.4 Voltage
The power supply should not be outside the indicated range of values. Use only chargers, batteries and
rechargeable batteries which are included in the scope of delivery.
Never use the 230 Volt mains supply.

1.2.5 Data safety
There can be errors in the process of data collection if
•

the range of the sender module is been exceeded,
OKM Ortungstechnik GmbH
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•

the power supply of the device is to low,

•

the cables you are using are to long,

•

other electronic devices sends out disturbances or

•

atmospherics occurs (lightnings, …).

1.3 Maintenance and Services
In this section you will learn how to maintain your measuring instrument with all included accessories to
keep it in good condition a long time and to get good measuring results.
The following list indicates what you absolutely should avoid:
•

penetrating water

•

strong dirt and dust deposits

•

hard impacts

•

strong magnetic fields

•

high and long lasting heat effect

If you want to clean your device please use a dry rag of soft material. To avoid any damage you should
transport the device and accessories always in the appropriate carrying cases.
Beware that all batteries and accumulators are always charged fully while operating with your system.
You should only load the batteries when they are completely discharged no matter if you are working
with the external power supply or with the internal accumulators. In this way a long durability of the
used batteries is guaranteed.
To load the external and internal batteries you have to use only chargers which are part of our
scope of delivery.

1.4 Danger of Explosion during Excavation
Unfortunately, the last two world wars also made the ground in many places of the world a potentially
explosive scrap heap. A host of those lethal relics are still buried in the ground. Do not start digging and
hacking for an object wildly when you receive a signal of a piece of metal from your device. Firstly, you
might indeed cause irreparable damage to a truly rare find, and secondly, there is a chance that the
object reacts in an insulted way and strikes back.
Note the color of the ground close to the surface. A red or reddish color of the ground is an indicator of
rust traces. As regards the finds themselves, you should definitely pay attention to their shape. Curved
or round objects should be a sign of alarm, especially if buttons, rings or little pegs can be identified or
felt. The same applies to recognizable ammunition or bullets and shells. Leave that stuff where it is, do
not touch anything and, most importantly, do not take any of it home with you. The killing machines of
war made use of diabolical inventions such as rocker fuses, acid fuses and ball fuses. Those components
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have been rusting away in the course of time, and the slightest movement may cause parts of them to
break and be triggered. Even seemingly harmless objects such as cartridges or large ammunition are
anything but that. Explosives may have become crystalline over time, that is, sugar-like crystals have
formed.
Moving such an object may cause those crystals to produce friction, leading to an explosion. If you come
across such relics, mark the place and do not fail to report the find to the police. Such objects always
pose a danger to the life of hikers, walkers, farmers or children.
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CHAPTER 2
Data transfer via bluetooth
In this section you will learn how to install the bluetooth software on your computer. This software is
necessary to transfer all measured data from your Rover C to the computer.
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Data transfer via bluetooth

2.1 Installation of bluetooth software
In the first section of this chapter it will be explained how to install the bluetooth software. Please note
that the represented figures do not necessarily correspond to the current version of your operating
system or the version of usb installation.

2.1.1 Install software and driver
The bluetooth software is situated on the software CD which is included in the scope of delivery. Place
the CD inside the CD Rom drive of your computer and wait until a window like shown in figure 2.1
appears.

Figure 2.1: Start screen when inserting in the software CD

Click on the entry Bluetooth, to start the installation of the bluetooth software and follow the
instructions on the screen of your computer, like it is explained in the following steps.

Step 1
Select the language and click on the button “OK”.

Figure 2.2: Installation of bluetooth software, step 1

OKM Ortungstechnik GmbH
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Step 2
Click on “Next >”.

Figure 2.3: Installation of bluetooth software, step 2

Step 3
Mark the entry “I accept the terms in the license
agreement ” and after that click on “Next >”.

Figure 2.4: Installation of bluetooth software, step 3

Step 4
Click on “Next >”.

Figure 2.5: Installation of bluetooth software, step 4
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Step 5
Click on “Install”.

Figure 2.6: Installation of bluetooth software, step 5

Step 6
Click on “Finish”.

Figure 2.7: Installation of bluetooth software, step 6

Restart your computer after finishing the installation, to agree to the changes on your system!

2.1.2 Configurate bluetooth dongle
After restarting your computer the bluetooth software should open automatically. Check if you can find
the bluetooth icon (grey/white) on the down right side of the task bar.

If you do not find this symbol there, you should start the bluetooth software manually. In this case just
click on the bluetooth symbol, which has been created on your desktop during the installation.

OKM Ortungstechnik GmbH
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Step 7
Double click on the new created bluetooth
symbol on your desktop to open a window
like here on the right side.

Figure 2.8: Installation of bluetooth software, step 7

Step 8
Plug in the bluetooth dongle in a free USB
connection of your computer. When the dialog
from the left figure appears click on “OK”.

Figure 2.9: Installation of bluetooth software, step 8

Now the bluetooth drivers will be installed on your computer. This can take several minutes, depending
on your computer. Please wait until all drivers are installed successfully and then continue with step 9.

OKM Ortungstechnik GmbH
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Step 9
Click in the menu on “View → Service window”,
to see the installed services.

Figure 2.10: Installation of bluetooth software, step 9

Step 10
Behind the entry “Serial Port A” you
can find the assigned COM port,
which you should select during the
data transfer in the software
Visualizer 3D.
In our example here it is COM6.

Figure 2.11: Installation of bluetooth software, step 10
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2.1.3 Setup connection
When you connect the device via bluetooth for the first time, to transfer data the computer, you should
enter the bluetooth passkey. The passkey is OKM (take care to write in capital letters!).

Step 11
When connecting the device to
computer the first time you should
enter the bluetooth passkey.
Enter OKM in capital letters and click
on “OK”.

Figure 2.12: Installation of bluetooth software, step 11

Step 12
When the bluetooth connection is established
successfully the bluetooth symbol in the task
bar will be visible in green.

Only after the bluetooth connection is successfully established, you can transfer data from your
measuring instrument to the computer.
The measuring instrument should establish the bluetooth connection always by itself. It is not
possible to search for the device via the bluetooth software. You only can use the bluetooth
dongle delivered with the device!

2.2 Uninstall bluetooth software
In this section it is explained how to delete the bluetooth software from your computer.
Therefor click on the entry Start -> All Programs -> IVT BlueSoleil -> Uninstall BlueSoleil
and follow the instruction on the screen of your computer. After uninstalling your bluetooth drivers you
should reboot your computer.

OKM Ortungstechnik GmbH
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Technical specifications

The following technical indications are medial values. During operation small variations are quite
possible. Technical changes due to development are possible!

3.1 Control unit
Dimensions (H x W x D) .............................................................................................. 390 x 140 x 300 mm
Weight ........................................................................................................................................ about 1 kg
Voltage ............................................................................................................................................ 12 VDC
Processor ....................................................................................................................... Motorola, 32 MHz
Data memory (control chip) ......................................................................... about 32700 measured values
Operating temperature ................................................................................................................. 0 – 50 °C
Storage temperature ................................................................................................................. -20 – 60 °C
Air humidity ............................................................................................................................... 5 % – 75 %
Waterproof ............................................................................................................................................. No
Sensor technology...................................................................................................................... SCMI-15-D

3.2 Data transfer
Technology .................................................................................................................................. Bluetooth
Frequency range .............................................................................................................. 2.4 – 2.4835 GHz
Maximum transfer rate ................................................................................................................... 1 Mbps
Receiving sensitivity ...................................................................................................................... -85 dBm
Maximum range ...................................................................................................................... about 100 m

3.3 Computer, minimum requirements
The indicated values should help you for a correct selection of a suitable computer for analysis of your
measured results.
CD-ROM drive ................................................................................................................................. min. 4x
Interface (data transmission) ............................................................................................................... USB
Free disk space ......................................................................................................................... min. 50 MB
Working memory (RAM) ......................................................................................................... min. 256 MB
Graphic card .......................................................................................... min. 128 MB, OpenGL-compatible
Operating system ............................................................................................ Windows XP, Windows Vista

OKM Ortungstechnik GmbH
www.okmmetaldetectors.com

4 Scope of delivery

CHAPTER 4
Scope of delivery

24

Scope of delivery

In the following section you can find all standard equipment and optional parts of Rover C.The scope of
delivery can be different in some circumstances because of some optional accessories which should not
be included in the basic equipment.
Description

Quantity

Control unit

1

Wireless headphones incl. 2 batteries (AAA)

1

Standard probe

1

Power Pack incl. charger and traveling adapter

1

User manual

1

Carrying case

1

Software "Visualizer 3D"

1

Bluetooth dongle

1

Control chip

2
Table 1: Scope of delivery

OKM Ortungstechnik GmbH
www.okmmetaldetectors.com

5 Control elements

CHAPTER 5
Control elements
In this section you will learn more about the fundamental use of all control elements for this measuring
instrument. All connections, inputs and outputs are explained in detail.
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5.1 Control unit
Figure 5.1 represents all control elements of the control unit of Rover C.
LED lamps

OK button

Display

Start button

Socket for
control chip

Socket for
power pack
Power
on/off button

Socket
for probe

Arrow keys

Figure 5.1: Overview of control elements of the control unit

Power on/off button: With the power on/off button you can switch on or off the device. Also the power
on/off button is used to activate/deactivate the internal speakers. When the device is powered off and
you press the power on/off button the device will be switched on and the LED of the power on/off button
will shine green. If the device is powered on and you press the power on/off button the integrated
speakers will be activated. If you press the power on/off button again, the internal speakers will be
deactivated. To power off the device, you should keep pressing the power on/off button until the devices
powers off and the integrated LED lamp turns out.
Start button: Primarily the start button is used to start a measurement and to release every single
impulse in the manual impulse mode. If you are in the main menu, the start button has an additional
function. With the start button you can also power on/off the integrated LED lamps on the bottom of the
device.
Socket for power pack: Before you can power on the device you should connect the delivered power
pack to the socket of power pack and switch it on. Information how to use the power pack you can find
in a separate enclosed user manual.
Socket for probe: At this socket you should connect the probe. Without the probe there is no
measurement possible.
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Socket for control chip: At this socket the control chip (hardware dongle) should be connected, to
guarantee a correct functioning of the device. Without connecting a control chip, the display will
indicate the message "Insert Control Chip" and a permanent signal tone will sound.
Display: The display of the device shows all operating modes, messages and measuring states. Below
the display there are 3 control buttons to operate the device. The OK button is mostly used to activate
the selected operating mode. In some circumstances this button is allocated with another function which
will be explained at the appropriate place inside this manual. By using the arrow buttons  and  you
can switch between the operating modes in the main menu and select the options in the submenus. With
these arrow buttons you can finish the measurement of an operating mode and get back into the main
menu.

5.2 Headphones
Figure 5.2 shows all control elements of the delivered wireless headphones.

Ear pad ( protective cap
for battery case)
Power on/off
button

Volume control

Frequency
regulator

Figure 5.2: Control elements of wireless headphones

To use the delivered wireless headphones, you should insert two charged micro type AAA batteries
inside the battery case. Therefor you should remove the ear pad on the left site "L" and insert the
batteries into the battery case. Pay attention to use the correct polarity. Now place the ear pad again on
the battery case and press carefully until it snaps into place.

OKM Ortungstechnik GmbH
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Power on the wireless headphones with the power on/off button (ON/OFF) and find the correct channel
with the frequency regulator (TUNE). The device Rover C should be powered on and release an acoustic
signal during this adjustment. The best way is to power on the device without connecting a control chip.
Then the message "Insert Control Chip" will appear in the display and a permanent signal tone will
sound, which you can use for the optimal setting of the wireless headphones.
Via the volume control (VOLUME) you can regulate the volume of the headphones.
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CHAPTER 6
Assembly
In this section is explained how to assemble the device and how to prepare a measurement.
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Assembly

Before you can use the device Rover C for a field measurement you should do some preparations. Please
pay attention to the following steps!

Step 1
Without the control chip the device cannot
be activated. It is used as a safety key.
Connect the control chip to the designed
socket!
Furthermore it is used as a memory chip to
store measured values. If you have several
control chips, you can store one
measurement on each chip!

Figure 6.1: Connect control chip

Step 2
The probe is used to measure the underground
values and should be connected to the socket on
the bottom of the unit. Avoid hard impact or
other damages.

Figure 6.2: Connect probe

Step 3
To supply the device with power, you should
connect the delivered power pack.
Plug in the connector of the power pack in
the designed socket and turn it to left or
right until it locks into place.
When you pull on the connector, it will be
detached from the socket.

Figure 6.3: Connect power pack for power supply
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Step 4
After connecting the power pack and
powering it on you can simply put it in your
trouser pocket or other pocket.
Now you should power on the device with
the power on/off button.

Figure 6.4: Pocket the power pack
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CHAPTER 7
Operating modes
In this section you will learn more about operating the device. Every operating mode will be explained in
a proper subsection.
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Every time when you power on the device with the power on/off button the device type and device
version will be displayed. After that, you will always see the selection to adjust the background light of
the display.
There are 3 different settings for the background light which you can select by using the arrow keys 
and :
•

Automatic
Automatic regulation of the background light. Within the selection menus the display light is
always on and during the activated operating modes (during the measurements) the display light
will be off.

•

On
The background light is always activated, which means that the display is always lighted.

•

Off
The background light is always deactivated, which means the display is always unlighted.

After you have selected the desired option with the keys  and  you should confirm this selection with
the button OK. Then you will enter into the main menu where you can select all available operating
modes.
The device Rover C offers the following operating modes:
•

1 Magnetometer
An acoustical magnetic field measurement will be done.

•

2 Ground Scan
A graphical measurement for analysis on a computer will be done.

•

3 Transfer Memory To PC
Measurement values will be sent from the internal memory (control chip) to a PC for analysis.

•

4 Super Sensor Discrimination
Measured values of the Supersensor for metal analysis will be sent directly to a computer.

The selection of the correct operating modes depends on the planned mission. Normally you should use
several operating modes one after another to explore an area. In this way you can obtain as much
information as possible from the underground of the scanned area.
The complete menu structure of Rover C you can find in figure 7.1 as a schematical representation.
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Figure 7.1: Overview about menu structure
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7.1 Magnetometer
In the operating mode "Magnetometer" you can research the area regarding to ferromagnetic1 metals.
This mode is only an acoustical mode, which does not create any graphical representation.
You can use the small standard probe or the larger Supersensor for this operating mode. By using the
high resolution Supersensor you can obtain a much more deeper penetration depth. Please note that it
can also react on metallic trash or contamination laying on the surface or near to the surface.
Power on the device and select the operating mode "Magnetometer" from the main menu. Press the OK
button to activate the operating mode. The display now shows the message " Magnetometer Active". At
this moment no sound should come from the device.

Figure 7.2: Probe should point always to the down and should not be turned

Now you can move slowly forward, backwards and sidewards, but should avoid turning the probe. The
probe should always point vertical to the ground and should not be turned around its own axis.

Do not swing !!!

Do not turn around !!!
Figure 7.3: Pivoting or turning of the probe falisifies the measurement

1

Ferromagnetic metals are for example iron, cobalt and nickel. Also other metals or objects, which include traces
of such metals can be detected.
OKM Ortungstechnik GmbH
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As soon as an acoustical signal sounds, the device has detected a possible metal target right under the
position of the probe. In this way it is possible to find small metals near the surface like for example
nails, screws, wires, seals and similar targets.
You should use the operating mode "Magnetometer", to remove such disturbing metal pieces from the
area, you like to scan. The less metals are laying near to the surface, the better will be your result in the
operating mode "Ground Scan". You can also find larger metal targets which are located deeper
underground. A general norm is: The larger the target, the deeper it can be detected underground!
Also you can use the operating mode "Magnetometer" as a useful pin-pointer during the excavations. If
you already have dug out a large hole and do not remember where exactly the detected object was
situated, you can simply use the Magnetometer mode, to relocate fast and efficient the target position.
To finish the operating mode "Magnetometer" and return back into the main menu you should press one
of the arrow buttons  or .

7.2 Ground Scan
The operating mode "Ground Scan" allows a graphical measurement of any area for analysis on a
computer. For the measurement you can either use the standard probe or the Supersensor.
Power on the device and select the operating mode "Ground Scan" in the main menu by using the arrow
keys  and . Press the OK button to activate the operating mode. Now you have the option to adjust
the 3 different parameters. The first parameter is the impulse mode and offers the following choices:
•

Automatic
Each measure value will be recorded automatically and continuously without any break.

•

Manual
One measure value will only be recorded after you have pressed the start button.

The second adjustable parameter is the number of measure points (Impulses), which will be recorded for
each single scanning path. The following choices can be made:
•

Auto
The number of measure points of one scanning path will only be defined during the
measurement. At the end of the first scanning path the start button should be pressed to save
the required number of measure points. This number of measure points will than be used
automatically for all following scanning paths. Beginning from the second scanning path the
device will stop by itself, when the defined number of measure points has been sent out.
If you select "Auto" you are not able to do a direct transfer to a computer. You can only store the
measured values in the internal memory of the device, because the exact length of field is not yet
selected.

•

10, 20, ..., 200
Each scanning path consists of the selected number of measure points. At the end of each
scanning path the device stops by itself, as soon as the number of measure points is achieved.
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In a final step you have to define the type of data transfer (Transfer Mode). You should select one of the
following choices:
•

Memory
The measured data will be stored in the internal memory of the device. After finishing the
measurement you should transfer the data to a PC by using the operating mode "Transfer
Memory To PC". You can only store one measurement at a time in the internal memory. As soon
as a new measurement will be recorded, the measured data from the previous measurement will
be deleted irrevocable.

•

Computer
The measured data will be transferred right away to a computer. Therefor a bluetooth
connection to a computer will be established before starting the measurement. The option
"Computer" is not available if the number of impulses (Impulses) has been set on "Auto".

After all parameters has been adjusted the device is ready to start the first scanning path. Beginning
from this moment the display will indicate the current number of scanning paths and the current
number of measured impulses per scanning path.

Number of scanning path
which is currently
executed

Number of measure points
per scanning path
Number of measure points
which has been recorded

Figure 7.4: Display representation in operating mode "Ground Scan"

The figure 7.4 shows the display which indicates that the first scanning path has begun and no impulse
has been measured up to now. In totally there will be 20 measure points per scanning path. The device is
waiting for the user to press the start button to begin the measurement recording.
Please go to your start position of the first scanning path and press the start button.
a)

If you have selected the impulse mode "Automatic" just keep going slowly until you have reached
the end of the first scanning path. When you already have defined the number of impulses than
the device will stop automatically at the end of the line, otherwise you should press the start
button when you have reached the end of the first scanning path. Now please go to the start
position of the next scanning path and press the start button again. The device will stop
automatically by itself at the end of the scanning path.
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Figure 7.5: "Zig-Zag" scanning in mode Ground Scan

b) If you have selected the impulse mode "Manual" you should press the start button to start your
measurement. Now you are using the manual scan mode, which means you should release each
single measure impulse manually one by one with the start button. The impulses will not be sent
out automatically. Now you should do a little step forward and press the start button, to measure
the second measure point. The device stops and you should do again a little step forward and
press the start button again. Now continue in this way until you have reached the end of the first
scanning path. If you already have defined the number of impulses per line, the device will
automatically signalize the end of the scanning path, otherwise you should press the OK button
when you like to finish the first line. Now go to the start position of your next scanning path and
press again the start button. Go another step forward and repeat the measurement in the same
way like you recorded the first scanning path. The device will now signalize automatically the
end of the next scanning path.
Continue to measure all further scanning paths until you have recorded the complete measure area. To
finish the operating mode "Ground Scan" and go back to the main menu you simply press one of the
arrow keys  or .

7.3 Transfer Memory To PC
By using the operating mode "Transfer Memory To PC" you can transfer measured data from the internal
memory of the device to a computer. Therefore it is necessary to plug in the bluetooth dongle into the
computer and to prepare the software to receive the data. As soon as all settings are made in the correct
way you can use this operating mode successfully.
Detailed information about the correct setting of the software you can find in the user manual of
the software.
Power on the device and select the operating mode "Transfer Memory To PC" from the main menu by
using the arrow keys  and . Press the OK button to activate the operating mode. The display of the
device shows now the message "Connecting To Computer ...". As soon as the device is ready to transfer
the data the message "Press Start" appears in the display. Press the start button to transfer all data from
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the internal memory to the computer. After sending all data the message "Disconnecting From

Computer ..." will appear in the display. The operating mode "Transfer Memory To PC" will be finished
automatically and you will get back into the main menu.

7.4 Super Sensor Discrimination
In the operating mode "Super Sensor Discrimination" you have the possibility to distinguish between
ferromagnetic and non-ferromagnetic metals. This operating mode is only visible in the main menu,
when the Supersensor is connected to the device. You cannot use the standard probe in this operating
mode. The figure 7.6 shows, how to retain the Supersensor during the measurement.

Figure 7.6: Position of the Supersensor during a measurement

Similar to the operating mode "Magnetometer", the Supersensor should point vertical towards the
ground. It should not be turned or pivoted.

Do not swing !!!
Figure 7.7: Discrimination with Supersensor

Normally this operating mode is used after you have executed a complete measurement in the operating
mode "Ground Scan". It is mainly used to analyze the detected object in detail. Due to the analysis of the
measurement results in the mode "Ground Scan" you can determine the position of a located object and
now know at which place inside the measure area you should research in detail with the Supersensor.
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In this operating mode all measured data will be sent directly to a computer. Therefore it is at first
necessary to set up the data transfer inside the 3d software. Figure 7.8 shows the configuration dialog of
the software "Visualizer 3D". Please be sure to select the operating mode "Discrimination" during the
configuration.

Figure 7.8: Configuration of the 3d software in operating mode "Super Sensor Discrimination"

To adjust the COM port correctly please also read chapter 2 ("Data transfer via bluetooth") on page 13!
Click on the button OK, when you have adjusted all parameters.
After you have prepared the software for the data transfer, please go near to the detected object, power
on the device and select operating mode "Super Sensor Discrimination" from the main menu by using
the arrow keys  and . Press the OK button to activate the operating mode.
After the data transfer to computer has been established you can press the start button to start the data
transfer and the measurement. Now you can slowly move the Supersensor from one side to another
above the possible object. Please try to capture the complete object, which means you should measure
beyond the edges of the object. Repeat this measurement a few times to get a clear signature of the
object. There are 3 different signatures, from which you can recognize a specific characteristic of any
target.

Ferromagnetic metals
Ferromagnetic targets have a positivenegative-signature.

Figure 7.9: Signature of a ferromagnetic metal target

The figure 7.9 shows a typical signature of a ferromagnetic metal like e.g. iron. The signature includes a
positive (red) and a negative (blue) amplitude. When looking closely you can see even 2 ferromagnetic
signatures. The first signature starts with a positive amplitude and the second signature starts with a
negative amplitude. The order is not important, it depends on the direction of movement of the
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Supersensor. If you keep moving the probe from one side to another, these 2 signatures will change
continuously.
Take care to move the Supersensor slowly and equal above the ground and above a detected object to
get a clear signature.

Non-ferromagnetic metals
Non-ferrous targets have a pure positive
signature.

Figure 7.10: Signature of a non-ferromagnetic metal target

The figure 7.10 represents a signature of a non-ferrous target. You can recognize that there is only a
positive amplitude (red). Additionally to the main amplitude there is another small peak, which is
typically for precious metals. Also here the order of amplitude and the small peak is not important and
depends on the scan direction.

Non-metallic targets
All non-metallic items have a pure
negative signature.

Figure 7.11: Signature of a non-metallic target

The last of the typical signatures is represented in figure 7.11. It is the signature of all non-metallic
targets and structures. These can be voids, tunnels or buried plastic pipes or boxes. You can recognize
that there is only a negative amplitude (blue).
To quit the operating mode "Super Sensor Discrimination" and get back into the main menu you just
have to press one of the arrow keys  or .
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CHAPTER 8
Field procedure
This chapter gives practical instructions about the general procedure of a measurement in an area. The
different measurement methods and procedures will be explained in detail.
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8.1 General scanning procedure
In general every measurement always starts on the bottom right corner of your scan area. Starting from
this point, you should walk scanning path by scanning path, whereby every following path is situated on
the left side of its previous path. During walking these lines, the measurement values will be recorded
and depending on the selected operating mode either transferred directly to a computer or saved into
the memory of the device.
The device stops at the end of each finished scanning path, so that the user can find the starting position
of the following path. In this way, all paths will be registered and the area will be measured.
Figure 8.1 shows all 4 possible starting positions and the corresponding first scanning path. Depending
on the composition of your terrain you can determine the optimal starting point for your measurement
by yourself.

3

2

Start of
1. scanning
path

End of
1. scanning
path
4

1

Figure 8.1: Starting position of a scan area

The scanning paths may be referred as to as "Zig-Zag" or "Parallel" traverses. Also the number of
impulses (measure points), which are recorded during one scanning path can be adjusted individually
depending on the size of your scan area (length of scanning path).

8.1.1 Scan Mode
There are two general techniques to survey an area with Rover C:
•

Zig-Zag
The starting position of two scanning paths next to each other is on the opposite side of the
measured area. You will record data on your scanning path and on the return path as well.

•

Parallel
The starting position of two scanning paths is always on the same side of the measured area. You
will only record data in one way and in one direction, while you should return and walk back to
the starting position of the next scanning path without recording data.

Figure 8.2 represents both techniques schematically.
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4

3

2

1

2

3

Start of
scanning
path

1

Zig-Zag scanning

Parallel scanning

End of
scanning
path

Figure 8.2: Scan modes to measure an area

During the measurement in scan mode "Parallel" you will start on the bottom right corner of your
measure area (point

) to walk and record a scanning path towards the right upper corner of the

measure area. After recording the first scanning path, you should walk back to the starting point of
scanning path 2 (point

), to start there the second scanning path. In this way all other paths will be

scanned, until you have reached the left side of your measure area.
During the measurement in scan mode "Zig-Zag" you will start also from the bottom right side of your
measure area (point

) to walk and record a scanning path towards the right upper corner of the

measure area. Different from the parallel measurement, you should continue recording data while
walking back the second scanning path. So you go to the starting point of the second scanning path
(point

) and scan in the opposite direction. In this way, all other paths will be scanned in the scan

mode "Zig-Zag" until you have reached the left side of your measure area.
The distance between the scanning paths should be constantly during one measurement but can vary
from measure area to measure area. If you mostly look for smaller targets than you should also select a
small distance between the paths! A standard rule is: The smaller the distance between the paths, the
more accurate will be your scan result!

8.1.2 Regulation of the number of impulses per scanning path
It is possible to select the number of impulses before starting the measurement or selecting the
automatic mode ("Auto") to adjust the number of measure points after finishing the first scanning path.
When the number of measure points has been configured, the device will stop automatically when this
number has been reached and waits for the start of the new scanning path.
In the automatic mode you should stop the measurement of the first scanning path by yourself, by
pressing the start button, as soon as you have reached the end of the first scanning path. This effective
amount of measure points will be used for all further scanning paths of this measurement. Starting from
the second scanning path, the device now stops automatically after the assumed number of impulses has
been reached.
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Keep in mind the number of impulses which you have recorded per scanning path. This amount
should be entered later in the software program, when transferring the data to a PC, to receive
correctly all measured data from your measuring instrument!
There is no special rule for selecting the right number of impulses. But there are different aspects which
has to be considered. These are for example
•

the length of your measured area and

•

the size of the objects you are searching for.

A preferable distance between two impulses is about 15 cm to 20 cm. The smaller the distance between
two impulses is, the more exactly the graphical representation will be. If you are looking for small
objects you have to select a smaller distance, for big objects you can increase the distance between the
impulses.
Figure 8.3 shows the effects of the distance and the number of impulses per scanning path for some
objects.

Figure 8.3: Effects of changing the number of impulses and their distance

Figure 8.4 shows the difference between very few impulses (left side) and much more impulses (right
side) on the same length of scanning path. Therefor the second record (right side) shows much more
details and also smaller objects can be seen.

Figure 8.4: Comparison of low and high number of impulses

Do not hesitate to record more measurements with different numbers of impulses. For example you can
scan a large area before doing a second detailed precision measurement. Especially for the search of
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bigger objects you can proceed like this. With this manner you can measure a larger area very quickly
and afterwards you can record only subsections of interest.
When walking the scanning paths you should not only take care of the number of impulses, you also
need to take care of your walking speed. Every scanning path should be measured with the same speed,
like the previous scanning paths.
Figure 8.5 shows what can happen, if you use different walking speeds in each scanning path.

4
2

Start of
scanning
path

3
4

3

2

1

1

Zig-Zag scanning

Parallel scanning

End of
scanning
path

Figure 8.5: Different walking speeds during scanning

Using a different walking speed in the scanning paths, will cause displacements in the scanning path.
Thereby it can happen that some places inside your scan area are not measured at all or other unmeant
places outside of your scan area will be included. Later when the recorded data will be transferred to
the software and combined to a 3d image, there might be unmeant falsifications.
In general, the following rule is valid: The smaller and equally you are walking while measuring each
scanning path, the smaller will be the distance between the measure points and the more accurate will
be your scan result!

8.2 Special advices for the field procedure
There are some aspects which you should take care of during the measurement. In principle the
obtained 3d graphic can be only as good as the measurement you have recorded. A false measurement
can create falsified graphics.
Before you start with a measurement in the field, you should think of what you are looking for and if the
selected area is suitable. Measuring without any plan will not give acceptable results. Please consider
the following advice:
•

What do you like to locate (graves, tunnel, buried objects, ...)? This question has direct effects on
the realization of a measurement. If you look for large targets, the distance between the single
measure points and scanning paths can be larger, as if you are looking for small targets.

•

Inform yourself about the area, where you are searching. Does it make sense to detect here? Are
there historical references which confirms your speculation? What type of soil is on this area?
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Are there good conditions for data recording? Is it allowed to search at this place (e.g. private
property)?
•

Your first measurement in an unknown area has to be large enough to get representative values.
All further control measurements should be adjusted individually.

•

What is the form of the object you search? If you are looking for an angular metal box, the
identified object in your graphic should have a form according to this.

•

To get exact values concerning the depth measurement, the object has to be in the center of the
graphic, which means it has to be framed by normal reference values (normal ground). If the
object is on the side of the graphic and not totally visible a correct depth measurement is not
possible and also measurement of size and form are limited. In this case, repeat the
measurement and change the position of your scan area, to receive an optimal position of the
anomaly inside of the graphic.

•

There should not be more than one object in a graphic. This will influence the exactness of depth
measurement. It is useful to scan partial areas over such targets.

•

You should do at least two control scans to get sure about your results. So you also can
recognize and isolate mineralized deposits.

8.2.1 Orientation of probe
During one measurement the probe should have always the same distance to the ground. Generally we
recommend a distance of about 10 – 15 cm from the surface of the ground.
If there are some obstacles like stones, wood or high grass inside of your scan area than you should start
the measurement right from the beginning in a higher distance of the probe to the ground. In such
circumstances you can measure in a distance of e.g. 50 cm above the ground. Important is that you keep
this distance during the complete measurement. In any case you should avoid to move up and down the
probe!
Another important aspect is the physical orientation of the probe. During the scan mode "Parallel" the
orientation of the probe does not change because you always measure in the same direction. During the
scan mode "Zig-Zag" the orientation of the probe will be turned about 180° at the end of each scanning
path (if you change your position together with the device, to walk back forwards and continue
scanning).
This change of orientation can influence negatively the scan result. Even if the Rover C processes an
integrated auto reversal electronics it can happen that the obtained graphic can include red or blue
stripes. In such a case you should repeat the measurement either in the scan mode "Parallel" or in the
scan mode "Zig-Zag" while avoiding a turn at the end of each scanning path and instead walking
backwards.
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8.2.2 Parallel or Zig-Zag?
For skilled users of Rover C both scan modes are suitable. According to experience the best graphics has
been received in the mode "Parallel", because always the same direction of scanning is used and the
walking speed can be coordinated in the most adequate way.
Specially in uneven territories like mountain sides, acclivities or other inclined layers the parallel mode
is preferred.

8.2.3 Manual or automatic impulse mode?
Large even surfaces can be measured in the automatic mode. The manual impulse mode is mostly used
in difficult territories or if the measurement result should be much accurate.
In terrains with difficult access like cliffy mountain sides, slippery surfaces or overgrown areas, it is wise
to use the manual impulse mode. Because each impulse will be released manually, you have enough time
to position the probe in the correct way and record the measured value. In this way, you can also
measure accurately previously marked dots of a predefined grid.
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CHAPTER 9
Tutorial
This chapter gives a detailed step-by-step procedure, which explains the process of a measurement by
means of some selected examples.
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9.1 Automatic measurement in Zig-Zag mode
Figure 9.1 represents a typical measure area which should be scanned with the Rover C. The red frame
marks the borders of the measure area. For this example we are using the following parameters:
•

Impulse Mode: "Automatic"
Automatic impulse mode, which records measure values (impulses) of a scanning path without
any interruption.

•

Impulses: "Auto"
Automatic determination of the impulses, which means the number of impulses will be defined
during the first scanning path.

•

Transfer Mode: "Memory"
Storage of measured data in the internal memory of the device. After finishing the measurement
the data has to be transferred to the computer by using the operating mode "Transfer Memory
To PC".

•

Scan Mode: "Zig-Zag"
The measure area is even and easy to access, that is why we have selected the scan mode "ZigZag".

 

 

Figure 9.1: Measure area for a survey in mode "Ground Scan"
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Now go to the start position

 of your measure area and power on the device by pressing the power

on/off button. Put on the headphones and power them on, so you can hear the acoustical signal of the
sending out of impulses. The display shows the selection menu of the background light. Simply press the
OK button to activate the automatic regulation for the background light. Now you can see the main
menu where you can select the operating mode "Magnetometer". Press one time on the button , to
select the operating mode "Ground Scan". Confirm your selected operating mode by pressing the OK
button. Now you can see the selection menu of the impulse mode (Impulse Mode). It is already set on
"Automatic". Confirm this selection by pressing the OK button.
The next parameter is the number of impulses (Impulses). The default setting is "20". Press two times
the arrow key , to select "Auto". Confirm your selection by pressing the OK button.
The last parameter is the method of transfer (Transfer Mode). The default setting is "Memory". Confirm
your selection by pressing the OK button.
The device is now ready to start the first scanning path. The display shows the message "Press Start,

L:1, I:0/?". The question mark "?" shows that the number of impulses per scanning path has not been
defined yet. As soon as you press the start button the measure values will be recorded continuously. You
will hear the acoustical signals via the integrated speakers or the headphones. On the basis of these
acoustic signals you can coordinate your walking speed. After pressing the start button you should walk
slowly and equally forward to point

 of the measure area and press again the start button so that you

do not hear any more impulses. The device is now in stand-by position. On the display you can now read
the automatic defined number of impulses per scanning path. For example there can be the following
message written in the display "Press Start, L:2, I:0/25" . Here 25 impulses has been defined.
Now you should go to the start position of your second scanning path (point

). Press the start button

and walk with the same speed like the first scanning path to the end of your second scanning path (point

). This time it is not necessary to press again the start button at the end of the scanning path. The
device will stop automatically when it has recorded the same number of impulses like in the first
scanning path.
Continue the measurement with the next few scanning paths until you have scanned the complete
measure area in the scan mode "Zig-Zag". When you have reached the end of the final scanning path,
press one of the arrow keys  or , to finish the measurement and go back into the main menu.
When leaving the operating mode "Ground Scan" you should keep in mind the number of
impulses which you have used per scanning path! This value you should enter when transferring
the data to the software!
In this moment the recorded data of your measure area is saved in the internal memory of your device
and should now be transferred to a computer for evaluation.

9.2 Transfer internal memory to computer
The data of your last measurement are saved in the internal memory of the device. Before you can
evaluate these measurement values graphically you should transfer them to a computer. The following
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section explains how you can transfer the saved measure values from the internal memory to the
delivered software "Visualizer 3D".

9.2.1 Prepare software "Visualizer 3D"
Before you can transfer any measured data you should prepare the "Visualizer 3D" software for a data
reception. Plug in the bluetooth dongle into a free USB port of your computer and start the program
"Visualizer 3D".
When the software is open, click on the menu entry File → New and set up the parameters according to
your previously recorded measurement!

Figure 9.2: Preparation of a new data transfer in "Visualizer 3D"

Select your measure instrument "Rover C" from the list.
As transmission method you should select "Bluetooth" and at the entry "Interface" define the correct
COM port at which the bluetooth dongle has been installed. Please also read the chapter 2 ("Data
transfer via bluetooth") on page 13! If you are using a preconfigured laptop you can find the correct
number of the used COM port on the attached sticker.
As operating mode you should select "Ground Scan" and enter in the space "impulses per scan line" the
recorded number of measure points per scanning path. In our example we have used 25 impulses. Now
you just have to select the scan mode, so that the computer can receive the data correctly. Therefore you
should mark the entry "Zig-Zag" and click on the button OK.

9.2.2 Establish bluetooth connection and transfer data
After having prepared the software "Visualizer 3D" to receive data, you should establish a bluetooth
connection between the Rover C and the computer. Power on the measure instrument and select the
operating mode "Transfer Memory To PC" with the arrow keys  and . Activate the selected operating
mode with the OK button and wait until the device establishes a connection to the computer. When you
are connecting the device the first time to the computer you should enter a password. The password is
OKM (written in capital letters!). Please read also the chapter 2 ("Data transfer via bluetooth") on page
13!

OKM Ortungstechnik GmbH
www.okmmetaldetectors.com

Tutorial

55

When the bluetooth connection is established successfully (the bluetooth icon in the task bar will be
green), press the start button on your measure instrument.
Now all measured data will be transferred and a graphical representation will appear in the "Visualizer
3D" software. Now click inside the software on File → Stop, to finish the data transfer to the software.
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9.3 Manual measurement in parallel mode
In figure 9.3 the measured area is represented again. In our second example it should be scanned with
the following parameters:
•

Impulse Mode: "Manual"
Manual impulse mode, where the measure values (impulses) of a scanning path should be
released manually. The device waits after each measure point for the user to release the next
impulse.

•

Impulses: "30"
Predefined fixed number of impulses, which means that the number of impulses should be
exactly 30 within the 1. scanning path and all following scanning paths.

•

Transfer Mode: "Computer"
Direct transfer of measured data to a computer. Before starting the measurement a connection
between device and computer via bluetooth should be established.

•

Scan Mode: "Parallel"
The measure area is even and easy to walk but it is also possible to select the scan mode
"Parallel".

 

 

Figure 9.3: Measure area for a survey in mode "Ground Scan"

Because all measured values will be transferred directly to the computer while scanning, you should at
first prepare the software to receive data.
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9.3.1 Prepare "Visualizer 3D" software
Plug in the bluetooth dongle into a free USB port of your computer and start the "Visualizer 3D"
software.

Figure 9.4: Preparation of a new data transfer in "Visualizer 3D"

When the software is open, click on the menu entry File → New and set up the parameters according to
your planned measurement!
Select your measure instrument "Rover C" from the list.
As transmission method you should select "Bluetooth" and at the entry "Interface" define the correct
COM port at which the bluetooth dongle has been installed. Please also read the chapter 2 ("Data
transfer via bluetooth") on page 13! If you are using a preconfigured laptop you can find the correct
number of COM port on the attached sticker.
As operating mode you should select "Ground Scan" and enter in the space "impulses per scan line" the
number of measure points which you plan to use for each scanning path. In our example we will use 30
impulses. Now you just have to select the scan mode, so that the computer can receive the data
correctly. Therefore you should mark the entry "Parallel" and click on the button OK.

9.3.2 Establish bluetooth connection
After having prepared the software "Visualizer 3D" to receive data, you should establish a bluetooth
connection between the Rover C and the computer. Power on the measure instrument with the power
on/off button. The display will indicate the selection menu for setting up the background lighting. Simply
press on the OK button to activate the automatic regulation of the lighting. After that you will enter into
the main menu where the first operating mode " Magnetometer" is visible. Press one time on the arrow
key , to select the operating mode "Ground Scan". Confirm the selected operating mode by pressing
the OK button. Now you entered into the selection menu Impulse Mode. The default setting is
"Automatic". Press the arrow key , one time to change to "Manual". Confirm the setting by pressing the
OK button.
As the next parameter you should select the number of impulses (Impulses). The default setting is "20".
Press one time the arrow key , to select "30". Confirm this setting by pressing the OK button.
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The last parameter is the method of data transmission (Transfer Mode). The default setting is "Memory".
Press one time the arrow key , to change to "Computer". Confirm this selection by pressing the OK
button.
The display of the device shows now the message "Connecting To Computer ...". When you are
connecting the device the first time to the computer you should enter a password. The password is OKM
(written in capital letters!). Please read also the chapter 2 ("Data transfer via bluetooth") on page 13!
As soon as the bluetooth connection has been established successfully (bluetooth icon in task bar shines
green) you can start with the measurement.

9.3.3 Performing a measurement
Go to the starting position

 of your measure area, put on the headphones and power them on to hear

the acoustic signal of the sending out of the impulses. The display shows the message "Press Start, L:1,

I:0/30". As soon as you press the start button you will hear a short impulse signal.
The display now shows the message"Press Start, L:1, I:1/30", which means that 1 of 30 impulses has
been measured. Now do a small step forwards in direction of point
nd

measure the 2

 and press again the start button to

impulse. You will hear again a short signal tone via the internal speakers or the

headphones. Repeat this procedure until the device indicates you the end of the scanning path and the
display shows the message "Press Start, L:2, I:0/30" .
Now go to the start position of your second scanning path (point

). Press the start button and measure

the second scanning path in the same way like the first scanning path. Continue your measurement for
all other scanning paths until you have scanned the complete area in the scan mode "Parallel". When
you have reached the end of the final scanning path press one of the arrow buttons  or , to finish the
complete measurement and return into the main menu.
While measuring the ground all data has been transferred at the same time to the computer and a
graphical representation has been created inside the "Visualizer 3D" software. Now click on File →
Stop, inside the software program to finish the data transfer to computer.
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